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1.Que és Mendeley?

Es una eina que combina varis aspectes: un gestor de referéncies bibliografiques, una
xarxa social académica i un cataleg col-laboratiu de literatura cientifica.

Ens permet guardar referéncies bibliografiques, gestionar-les, utilitzar-les en treballs i
bibliografies i compartir-les amb altres usuaris. També ens permet descobrir nova recerca,
crear grups publics i privats per col-laborar amb col-legues d’investigacié, guardar dades
associades a la nostra recerca (Mendeley Data) i cercar feina en I'ambit de la ciéncia i la
tecnologia.

B Mendeley Institucional (MIE) és la versié que la UAB ofereix a tota la comunitat
universitaria. Aquesta ofereix prestacions superiors a les que ofereix un compte
amb la versio gratuita de Mendeley. Més informaci6 a
www.uab.cat/biblioteques/mendeley/

€2 Si deixem de tenir vinculacié amb la UAB no podrem mantenir el nostre compte

MIE. Les condicions que tindran els alumnes ja graduats (ex-alumnes o alumni) sén les prestacions
de Mendeley free. Si durant el temps que han estat a la universitat s'han fet usuari MIE, disposaran de
12 mesos amb beneficis d’'un compte MIE. Transcorregut aquest temps Mendeley avisara l'usuari que
ja no forma part del col-lectiu MIE per a que prengui les decisions oportunes. Recomanem que, abans
de deixar la universitat, els usuaris s'assegurin que en la configuracié del compte hi consta I'adre¢a de
correu personal com a adrega principal en lloc de la de la universitat

Més informacio: http://www.uab.cat/doc/MendeleyAlumni

€3 Apps per a dispositius mobils: iPhone i iPad, Android
€) Guies i videos d’'ajuda a: community.mendeley.com/teaching (angles),
community.mendeley.com/quides (anglés) i www.uab.cat/biblioteques/mendeley/
(Apartat “Tutorials”)
2. Acces

2.1. Siteniu un compte a Mendeley free

e Des d’'un ordinador situat en el Campus de la UAB, aneu a
http://www.mendeley.com

e Cliqueu a Sign in (a la part superior dreta de la pantalla) i identifiqueu-vos amb el
vostre compte free

e En estar connectats a un ordinador del Campus UAB, Mendeley identifica que teniu
dret a un accés institucional i executa 'upgrade automaticament

e Comproveu des de la segiient adreca https://www.mendeley.com/account/details/
gue el vostre compte és Mendeley Institutional Edition

e A partir d'aquest moment, podreu accedir al vostre compte Mendeley des de
qualsevol ordinador amb tots els avantatges d’'un compte MIE

e Aquest accés sera valid durant un any, quan acabi aquest termini, rebreu un
missatge on es demana que, Si seguiu pertanyent a la comunitat UAB, renoveu el
vostre acceés institucional. Per fer-ho, cal que torneu a accedir al vostre compte
Mendeley des d’un ordinador situat en el Campus UAB UAB i es fara la renovacio
de manera automatica.

2.3. Sino sou usuaris de Mendeley

e Des d’'un ordinador situat en el Campus de la UAB, aneu a
http://www.mendeley.com
e Creeu un compte omplint les vostres dades personals i academiques
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e En estar connectats a un ordinador del Campus UAB, Mendeley identifica que teniu
dret a un acceés institucional

e Comproveu des de la segiient adreca https://www.mendeley.com/account/details/
gue el vostre compte és Mendeley Institutional Edition (MIE)

e A partir daquest moment, podreu accedir al vostre compte Mendeley des de
gualsevol ordinador amb tots els avantatges d’'un compte MIE

e Aquest accés sera valid durant un any. Quan acabi aquest termini, rebreu un
missatge on es demana que, Si seguiu pertanyent a la comunitat UAB, renoveu el
vostre acces institucional. Per fer-ho, cal que torneu a accedir al vostre compte
Mendeley des d’'un ordinador situat en el Campus UAB i es fara la renovacio de
manera automatica.

Un cop fet aquest tramit les seglients vegades entreu al programa a www.mendeley.com

£ Més informacio a www.uab.cat/biblioteques/mendeley/

£3 Es pot canviar el compte de correu per accedir a Mendeley
Web: Settings & privacity ->Account

€3 Sisesborra el compte de Mendeley es suprimeixen totes les dades pero el compte
Elsevier continua actiu. Per esborrar el compte Elsevier cal escriure a
'adreca de correu: support@elsevier.com

3. Doble plataforma : Online vs offline

2 plataformes de treball connectades pel boto

s |
Lo

Sync

1. Local (Mendeley Desktop). Eina d’escriptori pensada per gestionar les
referéncies, citar i visualitzar els PDF. Necessita instal-lacio i es pot descarregar a
www.mendeley.com/download-mendeley-desktop/. Es pot instal-lar a tots els
ordinadors que vulguem. Compatible amb Windows, Mac i Linux. Estructura de la
pantalla en columnes: esquerra (carpetes, grups i filtres), central (llistat de
referencies) i dreta (per editar i modificar referéncies)

2. Online (Mendeley Web). Versi6 al nuavol (www.mendeley.com) pensada per
contactar amb altres investigadors i crear grups de treball. Estructura de la pantalla
en pestanyes:

Feed: novetats i activitat dels meus contactes i grups

Library: gesti6 de referencies, carpetes i visor de pdf

Suggest: suggeriment de nous documents basant-se en els que ja tenim al nostre
compte

Stats: possibilitat de vincular el perfil d’autor de Scopus al compte Mendeley.
Es poden integrar els articles del perfil de Scopus i obtenir estadistiques d Us

Groups: permet accedir i gestionar els grups dels que formem part

Datasets: €s un repositori gratuit de dades de recerca. Ens permet guardar

dades amb amplies opcions quan a formats, accessibilitat i llicencies. Podeu

trobar una taula comparativa de repositoris a: ddd.uab.cat/record/150829

Funding: per coneixer diferents tipus de financament i beques

Search: Papers (per cercar al cataleg col-laboratiu de Mendeley), People i Grups
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(em mostra els meus grups i els investigadors que segueixo o em segueixen |
permet cercar d’altres).

M Feed Library Suggest Stats Groups Datasets Careers Funding Q. Search

Papers People Groups

a

€2 Bona part de les tasques es poden fer indistintament amb la plataforma local i web;
pel que fa a la gesti6 de les nostres referencies, Mendeley Desktop déna més
prestacions

E) La sincronitzacié la fa el programa per defecte en el moment en que ens
identifiquem en el Mendeley Desktop. La resta de vegades cal que la fem nosaltres
des del Mendeley Desktop clicant en el boté Sync. Podem sincronitzar tota la base

de dades o seleccionar la/es carpeta/es que vulguem des de [Edit 35ttings

En el moment que sincronitzem Mendeley cerca quina plataforma (Desktop o Web)
té les dades més recents i sén aquestes les que manté

B Per tancar la sessio de Mendeley Desktop (recomanable si esteu en un ordinador
public): Primer sincronitzeu; després aneu al desplegable File = Sign out. Al tornar
a entrar, en la finestra d’identificacié, podem deixar marcada o desmarcar I'opcio
Stay signed in que fa que se’ns obri la nostra sessio a I'obrir el Desktop

4. Creacio d’una biblioteca personal
Recordeu que cal sincronitzar per veure les referencies en totes dues plataformes.
4.1 Importacié mitjancant Web Importer (Import / Save to Mendeley)

Complement que ens permet importar referéncies i PDF des del web. S’ha d’instal-lar al
navegador seguint les instruccions de la pagina www.mendeley.com/reference-
management/web-importer/. Web importer és compatible amb el Cercador de les
biblioteques de la UAB, diferents bases de dades (Science Direct, PubMed), revistes
digitals, alguns catalegs (com el CCUC), i varietat de webs (wikipédia, Google scholar,
Amazon)

£2 Les referéncies s'incorporen a la plataforma web. Per veure-les en Mendeley
Desktop haureu de sincronitzar.

£ Web importer permet descarregar les referéncies d’una en una o totes les de la
pagina que esteu visualitzant.

€2 Abans de descarregar-les les referéncies es podeu editar, modificar i afegir-les a
una carpeta.

£3 En alguns casos podrem importar els PDF associats a les referéncies. Si no
podem importar el PDF, els podem guardar al nostre ordinador i posteriorment
incorporar-los mitjangant Drag and Drop o des de la columna de la dreta
(visualitzacié de la referéncia) a I'apartat Files. Si incorporem una referencia i el seu
PDF per separat el sistema els uneix.
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4.2 Importacié mitjancant Drag and Drop (arrossegar i deixar anar)
Permet incorporar a Mendeley Desktop referencies i PDF des de:

4.2.1 Bases de dades i revistes digitals que no admeten el Web importer. Haurem de fer
una exportacio indirecta guardant el fitxer de text (preferiblement en format RIS) al
nostre ordinador i despres arrossegar-lo a Mendeley Desktop

4.2.2 Referencies provinents d’altres gestors (Zotero, Refworks)

4.2.3 PDF que tinguem al nostre ordinador (provinents de bases de dades....)

4.2.4 Carpetes amb PDF i documents de text

Podem fer el mateix des de diferents botons de Mendeley Desktop: Desplegable Add
Files/Add Folder, File > Add Files, File - Import

D Aira opcid d’importacié relacionada és mitjangant Watch Folder que permet que el
sistema importi automaticament els documents en pdf que tenim en una carpeta del
nostre ordinador. Els documents s’incorporaran a la carpeta Unsorted
Tools>Options>Watched folders

Tools>Options->File Organizer: Fa una copia al disc dur de l'ordinador dels arxius
(PDF, Words...) que tenim a Mendeley Desktop i els organitza: els anomena
seguint una pauta que nosaltres definim i també els pot ordenar en carpetes i
subcarpetes

4.3. Importacio des del Cataleg col-laboratiu de Mendeley
El cataleg col-laboratiu de Mendeley s’alimenta de les referencies que inclouen els usuaris

Podem cercar a Mendeley Web clicant sobre la lupa (part superior dreta de la pantalla) i
s’obrira un grup de pestanyes entre les quals trobareu Papers

a

Mendeley Desktop: columna esquerra >Literature Search
També podem importar documents relacionats amb un document: boté dret del
ratoli>Related documents

A més d’importar la referéncia, Mendeley ofereix I'enllag extern a la pagina de I'editor. De
cada referencia es mostra el numero d’usuaris de Mendeley que tenen aquesta referéncia
al seu compte i el numero de cites rebudes (el numero de cites s’obté de la base de dades
Scopus)

+ Add to library  [4 Get full text at journal

Clicant sobre el titol accedim i al registre complet. Amb 'opcié “Find this document”
enllacem amb el Cercador de les Biblioteques de la UAB, podem comprovar la
disponibilitat del document i accedir al text complet si és un recurs subscrit per la
universitat.
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Find this document

Els PDF que puguem trobar en aquests enllagos al text complet no es poden importar
directament a Mendeley. S’han de descarregar a I'ordinador i després importar-los
mitjangant Drag and Drop .

) Podeu excloure una referencia per tal de que no formi part del Cataleg
Col-laboratiu de Mendeley. Per excloure-la aneu a la visualitzacié de la referéncia a
Mendeley Desktop o Web (columna de la dreta al final). Per excloure diverses
referéncies de cop ho heu de fer des de Mendeley Desktop - amb Ctrl més clic
seleccioneu les referéncies que voleu (amb Ctrl + A les seleccionareu totes)2>A la
columna de la dreta marqueu Unpublished work- exclude from Mendeley catalog.

E£3 A Mendeley Web, si anem a la pestanya Suggest, trobarem suggeriments de
documents a partir del contingut de la nostra biblioteca personal.

£3 En Mendeley Desktop, visualitzant una referéncia, podem cercar per identificadors
(DOI, arXiv i Pubmed) i el sistema cerca en aquestes plataformes i omple
automaticament les dades de la referencia; molt Gtil també per completar dades de
referéncies que hem importat.

£3 Si teniu una bibliografia feta amb el gestor de referéncies bibliografiques del word o
una bibliografia sense formatejar podeu importar-la a Mendeley fent servir una eina
gue es diu Eewoww 2> www.eewoww.com/ Heu de crear un compte gratuit i seguir
les instruccions que trobareu en aquest post del blog In plain sight

4.4. Introducci6é manual de referencies

A Mendeley Desktop: File - Add Entry Manually

A Mendeley Web: My library - columna esquerra bot6 - New manual entry

5. Gestionar carpetes i documents
Treballarem aquest apartat a Mendeley Desktop que dona més prestacions

5.1. Gestionar carpetes
5.1.1. Carpetes per defecte del programa
e All documents: tots els documents
e Recently added: ultimes referéncies afegides
e Recently read: ultimes documents llegits
e Favorites: referéncies marcades con favorites
e Needs review: visible quan tenim referencies, inclou aquelles referencies que
necessiten ser revisades (comprovar metadades)
e My publications: publicacions de les que som autors
e Unsorted: referencies que no tenim a cap carpeta

5.1.2. Creaci6 de carpetes
Create folder de la columna esquerra o icona ¥ . Per crear una subcarpeta cal

seleccionar la carpeta mare i clicar la mateixa icona.
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5.2.
5.2.1 Buscar referéncies

5.1.2. Reanomenar i esborrar carpetes
Boto dret de ratoli > Rename folder o Remove folder

Una altra opci6 per esborrar carpetes - My library, seleccionar carpeta que es vol

esborrar i clicar =

5.1.3 Copiar/moure referéncies d’una carpeta a una altra

Per copiar referencies en una carpeta determinada, només cal seleccionar-les i
arrossegar-les a la carpeta de desti.

Per moure referéncies, cal suprimir la referéncia de la carpeta on esta - boto
dret ratoli - remove from folder, aquesta passa a la carpeta Unsorted i des
d’aqui la podem moure a una nova carpeta

Per veure en quina/es carpeta/es tenim una referéncia, la seleccionem i veurem

gue les carpetes on esta inclosa es marquen de color gris

Quan esborrem una carpeta el seu contingut passa a la carpeta Unsorted

Les referéncies que esborrem des de la carpeta Unsorted passen a la Trash. No
s’esborren definitivament fins que no buidem la paperera

Per esborrar referéncies d’'una carpeta > seleccionem la carpeta i la referéncia i
amb el botd dret del ratoli: Remove from folder (I'esborra d’'una carpeta) o Delete
documents ('esborra de totes les carpetes)

Mendeley Web

e Crear carpetes: My library > columna esquerra = /2= Folder
e Per crear subcarpetes, reanomenar i esborrar carpetes: My library - columna
esquerra - icona que hi ha al costat de cada carpeta

e Per copiar referéncies d’'una carpeta a una altra o a un grup: My library >
Seleccionar les referéncies a moure i escollir carpeta o grup de desti des de >

byl Addto |
situat a la columna central

Buscar i editar referéencies

Seleccionem All documents si volem fer la cerca a tota la biblioteca o una carpeta en
concret i cerquem des del desplegable:

Q-
Authors Search
Titles
Publication Mames
Year
Mokes

Els termes que cerquem surten destacats
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£) Cercaal text complet dels PDF

Mendeley Web

Pestanya My library = columna dreta = Hbrary search

No cerca al text complet dels PDF. Busca a All documents

5.2.2 Editar referéncies

e Ordena les referencies per: marcats com a favorits, llegits, contenen adjunts, autor,
titol, any, titol publicaci6, data afegit a Mendeley

* @ | E Authors Title Year | Published In Added

e Podem canviar la visualitzacio de les referéncies (columna central) a View i escollir
si les volem veure en format taula o en format de citacié (i aleshores haurem
d’escollir el format a Citation Style)

e Editar una referencia: es posem a sobre d’una referéncia. A la columna de la dreta

tenim els camps editables, pestanyes | D=t | Nates | podem escollir els camps

gue es visualitzen a Tools—>Options->Document details

e Editar multiples referencies a la vegada: seleccionem els documents que volem
editar pressionant Ctrl i fent clic - afegirem les dades que poden ser tags, notes,
etc...

e Per comprovar duplicats i validar autors, publicacions i tags anem al desplegable
de la columna esquerra (part inferior) i arrosseguem I'entrada incorrecta cap a la
correcta.

l&r by Authors r |

T 0By TR i

Fornaro, 1

Foti, G

Galanopoulou, Aristea 5
iGalbraith, J.K
Galbraith, John Kenneth

El programa ens demanara confirmar els canvis

I B Confirmation |i|£—hj

Rename all instances of "Galbraith, 1.K" to
"Galbraith, John Kenneth"?

Do not ask again

[ oK ] | Cancel

Mendeley Web

. N .. . z * Edit
Seleccionem una referéncia i editem els camps des de la columna dreta boté 7 '
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No permet editar diverses referéncies a la vegada

5.2.3. Buscar referéncies duplicades

Seleccionar la carpeta o conjunt de documents on volem buscar duplicats - Tools >
Check for duplicates > es mostren el/s grup/s de duplicats. La barra de la columna
Confidence es mostra el grau de coincidéncia dels camps segons Mendeley.

Des de la columna dreta podrem veure exactament quins camps son iguals i quins no.

Si finalment decidim fusionar les referéncies cliquem al bot6

Per desfer I'accié Edit = Undo o Ctrl Z

5.2.4. Buscar per indexs
Hi ha quadre filtres que permeten cercar referencies per:

Filter by Authors =

Filter by Author Keywaords
Filter by My Tags
Filter by Publications

5.3. Visor de pdf. Notes personals

Mendeley Desktop té un visor de PDF que permet crear notes, copiar una part del text i
destacar contingut dins documents PDF.
Seleccionar un arxiu PDF

- destaca un text determinat. Podem seleccionar el color a
= crea una nota alla on tinguem el cursor
Al -

selecciona una part del text.

Per desfer els canvis Edit = Undo o Ctrl Z
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B Podem compartir el document amb un grup per a que tots els membres puguin
veure les notes. Aquestes sén visibles des de la columna dreta pestanya Notes. Al seu
costat la pestanya Contents ens permet navegar pel sumari del PDF

Detais | ot

Dos membres d'un grup privat poden editar de manera simultania un mateix PDF i,
guan sincronitzin tots dos, podran veure les modificacions introduides per altres.

Opci6 per exportar el document amb les notes File > Export PDF with
annotations

£2 Perimprimir un PDF: obrir-lo >File ->Print. Podem imprimir-lo amb anotacions

Mendeley web
Visor de PDF que permet cercar dins el document, crear notes, copiar una part del text i
destacar contingut dins documents PDF amb les opcions del menua superior

6. Llistar i inserir la bibliografia en un text

Tot aquest apartat es fa des del Mendeley desktop

6.1. Llistar bibliografia

Aneu a View->Citation Style i escolliu un estil de citacio; si no veieu l'estil que voleu el
podeu trobar a More Styles - Get more Styles

Ara heu de seleccionar les referéncies que voleu llistar. Per aixo a la columna de
'esquerra, apartat My Library, podeu seleccionar una carpeta o escollir All Documents...
Situeu-vos a la columna central i escolliu:

- Totes les referéncies d’una carpeta: bot6 dret del ratoli > Select All (Ctrl +A).
- Algunes referéncies: Seleccioneu-les amb el punter i Shift
Un cop seleccionades amb el bot6 dret del ratoli aneu a Copy As > Formatted Citation.

Funciona igual si feu un copiar “normal” (Ctrl +C)
Obriu el processador de textos i enganxeu-les (Ctrl +V)
Si volem canviar I'estil haurem de fer tot el procediment de nou.

(+] Per combinar estil de citacié amb la llengua de la bibliografia anar al menu View »>
Citation Style > More Styles (i al final de la finestra emergent) - triar la llengua del
desplegable Citation and bibliography language

+ Per defecte les referéncies incorporen URL que no corresponen a la font original (i.e: urls
dels catalegs). Com eliminar-les? Cal canviar I'opci6 per defecte al Desktop 2> View -
Citation Style > More Styles (i al final de la finestra emergent) - Include URLs and Date
Accessed in Bibliographies = escollir opcié Only for Webpages del desplegable
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6.2 Instal-lar Mendeley Citation Plugin
Anar a Tools - Install MS Word Plugin

B cal tenir el word tancat per instal-lar el plugin

6.3 Inserir la bibliografia en un text

S’instal-la el plugin al processador de textos. Per exemple al Word 2010 a la Pestanya
Referencias veureu:

™  Style: | Chicago Manua... = |-

'8 =
L Insert Bibliography *-El

Inzert Export

Citation (£] Refresh g

Mendeley Cite-C-Matic
Insert citation - cerquem la referéncia des de la pantalla emergent o anem a Mendeley
19

Desktop - seleccionem referéncia - icona ¢t

Un cop tinguem les citacions inserides, cal seleccionar Insert Bibliography per generar la
bibliografia. Si inserim noves citacions al text o canviem l'estil de citacid, la bibliografia
s’actualitza automaticament

£ Per modificar una cita (exemple incloure la pagina), un cop inserida la citacié en el
vostre document, posicioneu-vos sobre ella. Veureu en el menu del Word de
Mendeley (Mendeley Cite-O-Matic) l'opcié Edit Citation. A la finestra emergent,
posicioneu-vos una altra vegada sobre la citaci6 que voleu modificar i us
apareixeran les opcions per editar-la. Podeu afegir, per exemple, una pagina.

Page
Prefix
SufFix

[ ] suppress author

My Libraty [ﬂ Go To Mendeley] [ I ] [ Cancel

£3 Utilitzeu l'opcié Refresh quan feu algun canvi a la referéncia des del Desktop (per
exemple si canviem any, nom de l'autor....) 0 a Mendeley web (i posteriorment cal
sincronitzar)

€3 Per fer cites a peu de plana: Escollim a Mendeley Desktop > View —>Citation Style
un estil propi de notes al peu com Chicago (note). Citem normal amb Mendeley.
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m 6.4 Personalitzar estils de citacions

Des de Mendeley Desktop - View - Citation styles - More styles
e Per comencar a fer un nou estil de citacié podem agafar un existent i amb el boto dret
del ratoli anar a Edit style. Ens haurem d’identificar

e La segulent pantalla que apareix és el Visual Editor CSL. Podem clicar sobre el camp
de la citacio que volem canviar; a la part inferior de la pantalla veurem els canvis que
podem realitzar.

) Més informacié: www.mendeley.com/guides/csl-editor

7. Treballar en grup

Encara que també es pot fer a Mendeley Desktop treballarem aquest apartat des de
Mendeley Web

7.1 Crear grups
Els grups us permeten compartir informacio i col-laborar amb altres usuaris de Mendeley.
3 Tipus:
Private Invite only Open
Qui? Només els membres Tots poden veure el Tots poden veure,
veuen el contingut contingut. Només els sequir, afegir
convidats poden afegir referéncies i comentar
referéncies i comentar
Que? Referéncies i text complet | Referéncies Referéncies
Permet | Compartir en privat Compartir referéncies o Fer bibliografies
documents i notes bibliografia recomanada. col-laboratives o
seguiment d’un tema.
Ideal per | Grups de recerca Professors (fer visibles les Usuaris de Mendeley
bibliografies)
Icones Administrador del grup Administrador del grup Usuaris poden unir-se al
convida els membres convida els membres grup

3 Meés informacio: www.mendeley.com/quides/groups/02-types-groups

9 Important

ﬂCoses que es poden destacar
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+ Create a new group
e Per crear un grup - Pestanya Groups -

e Desde la pestanya Settings podem marcar quines notificacions volem que ens arribin
per mail
o Des de Mendeley web podem afegir referéncies a un grup de dues maneres, pestanya

Documents > icona T 99 o des de My library - Groups

B Amb el compte MIE es poden fer grups privats il-limitats amb un maxim de 100
membres cadascun

L'espai d'emmagatzematge per a grups €s de 100 GB; I'espai compartit dels grups
nomeés es descompta a la persona que ha creat el grup, no als altres membres

Mendeley Desktop
Columna esquerra—> Groups—> Create group

Per canviar les caracteristiques del grupl E3t 2=tings

Per incorporar referéncies a un grup vegeu 5.1.3 Copiar/moure referéncies d’'una
carpeta a una altra

Els comentaris que fan els membres del grup (pestanya Overview) només es veuen a
Mendeley Web

7.2. Cercar grups i persones

7.2.1.Cercar grups
A la pestanya Groups podem veure els nostres grups i cercar altres que ens interessin.
També podem cercar grups des del quadre superior de cerca

Papers People Groups

2

Podem seguir els grups, participar-hi (en els oberts) o demanar participar-hi (en els
grups amb invitacio)

7.2.2. Cercar persones

Podem cercar altres investigadors clicant sobre la lupa a la part superior de la pantalla:
Papers People Groups

a

Es poden seguir perfils personals i estar al dia de les actualitzacions. Només es fara
publica informacié que estigui aixi definida als perfils personals.
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Com a propietaris del nostre perfil també podem decidir qui acceptem com a seguidor
clicant sobre el desplegable situat al costat del nostre nom (part superior dreta de la
pantalla) - Settings and privacy - Privacy

Followers

Only let people whom | approve follow me

7.3. Sobre els drets d’autor

Cal respectar les llicéncies dels proveidors a I'hora de fer publics els articles. Respecte als
grups privats vinculats al CBUC, en general es poden compartir articles per a usos
acadéemics i no comercials.

Cada usuari és responsable de I'is de la documentacié que posa a Mendeley, no la
institucio.

#) Miés informacio: www.mendeley.com/terms/

8. Altres eines
8.1.Create/restore backup

e Per crear la copia de seguretat des de Mendeley Desktop —> Sync la base de
dades per tal de fer la copia de la versié més recent (web o desktop) > Help - Create
backup. Es genera una carpeta zip MendeleyBackup

e Per restaurar I’arxiu Help - Restore backup - Triar I'arxiu i verificar I'accio “I want to
restore all my data”

r'm Restore Mendeley Des... W

This will delete all vour Mendeley data
{stored locally and on Mendeley Web)
and restore wour library from the
selected backup.

This feature should not be used for

migrating your library between
compukers

IF wou are sure you wank ta da this,
please bype the Following text into the
bos below:

I want ko restore all my data

Restore My Data

9 La restauracio de la base de dades restaura les referéncies pero no els arxius
adjunts que contigui el compte
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€3 8.4. Sincronitzacié Mendeley-ORCID
ORCID és un web que ens permet identificar-nos com autor de publicacions cientifiques a
partir d’'un codi alfanumeéric. Cal anar al nostre perfil personal de Mendeley i anar a 'opcid

Create or Connect your ORCID iD(®

Teniu instruccions detallades a la “Guia para vincular Mendeley con ORCID e
importar publicaciones” elaborada per la Biblioteca de la  Universidad
de Ledn buleria.unileon.es/handle/10612/6121
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